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Introduction 
Microboards PrintWrite 2 software is designed to be the disc publishing solution for use with any of the 
Microboards Disc Publisher models.  Whether you are publishing only a few discs a day on a G4 Disc 
Publisher or thousands on an MX Disc Publisher, PrintWrite 2 is the publishing software designed by 
Microboards specifically for your disc publishing equipment. 
PrintWrite 2 uses SureThing Disc Labeler software to design your disc labels. 

Local Client vs. Remote Client Use 
PrintWrite 2 gives you the option of making your Disc Publisher accessible to other PCs on your network.  
This allows multiple people to publish discs from their own PCs using a single Disc Publisher.  Operation 
will be slightly different if you are using a Publisher connected directly to your PC as opposed to using a 
Publisher connected to another PC on your network.   
The terms Local Client and Remote Client will be used throughout this manual and in the PrintWrite 2 
Help pages.  Please familiarize yourself with the meanings of these two client types. 

Local Client  
If you are using a Disc Publisher that is connected directly to and installed on your PC, you will be operating 
PrintWrite 2 as the Local Client with your PC being the Local Client PC.  The full hardware installation is 
required as well as the installation of PrintWrite 2 and SureThing Disc Labeler.   
As the Local Client, you will have administrative control over the Disc Publisher connected to your PC, 
including control over all jobs submitted to the Disc Publisher.  
The Local Client PC has configuration requirements that must be met before other PCs can connect to the 
Disc Publisher.  These requirements are specified in the Local Client Installation and Configuration 
section of this manual (see pages 8-9), as well as in an abbreviated reference list on page 36. 

Remote Client  
If you are using a Disc Publisher that is connected to another PC on your network, you will be operating 
PrintWrite 2 as a Remote Client with your PC being a Remote Client PC.  It is not necessary to install the 
Disc Publisher hardware on your PC to be a Remote Client, but PrintWrite 2 and SureThing Disc Labeler 
must be installed. 
The Remote Client is more limited than the Local Client.  Some of the duplication project types such a 
Batch Copy or Copy Disc that require direct access to the Disc Publisher itself are not allowed, for instance.   
Also, the Remote Client can only affect those jobs submitted from the Remote Client PC.  Anything that the 
Remote Client cannot do will be listed in this manual as specific to the Local Client. 
For each Disc Publisher, there must be one Local Client, but there may be multiple Remote Clients. 
NOTE:  Remote Client and Local Client PCs must be members of the same Network Domain or Workgroup.  

Mixing different Domains and/or Workgroups may result in difficulty connecting a Remote Client PC to a 
Local Client PC.   
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Microboards Disc Publishers 
Microboards PrintWrite 2 software is designed to be the disc publishing solution for use with the supported 
Microboards Disc Publishers listed below. 

Using PrintWrite 2 with any other burning and printing hardware is not supported! 

G4 Disc Publisher 
Input/Output Capacity:  50 discs 
Number of Drives:  1 
Print-Only Mode:  Uses PrintWrite to print labels or print directly out of 

other applications 
Microboards G4 Disc Publisher is a robust, versatile entry-level 
publishing system.  Featuring a 50-disc input/output capacity, dual ink 
cartridge system, 4800 dpi inkjet printing, and a high-speed DVD/CD 
recorder, the G4 is perfect for low- to mid-volume requirements.  
Churches, schools, audio recording studios, and video production 
houses will all benefit from its rapid output, ease of use, and low 
operating cost.   

MX Series Disc Publishers 
Input/Output Capacity:  100 discs 
Number of Drives:   MX-1: 1 recorder drive 
 MX-2: 2 recorder drives 
Print-Only Mode:  Uses PrintWrite to print labels or print directly out of 

other applications 
The MX-1 and MX-2 Disc Publishers are ideal for organizations that 
need to produce anywhere from one to thousands of discs! Designed 
for industrial environments, the MX comes with either 1 (MX-1) or 2 
(MX-2) high-speed DVD/CD or BD/DVD/CD recorders and the 
industry’s fastest, lowest cost-per-disc inkjet printer, all integrated into 
a robust publishing solution. 

G3 Disc Publisher 
Input/Output Capacity:  50 discs 
Number of Drives:  1 
Print-Only Mode: Prints directly out of SureThing or other applications  
The G3 Disc Publisher is designed for office desktop use and is the 
perfect solution for businesses and organizations requiring short runs 
of discs. 

CX-1 Disc Publisher 
Input/Output Capacity:  100 discs 
Number of Drives:  1 
Print-Only Mode:  Prints directly out of SureThing or other applications 
For all-in-one publishing, the CX-1 Disc Publisher gives you all of the 
features and benefits of the PF-3 Print Factory® with an added high-speed 
DVD/CD recorder and a complete software suite. The industrial CX-1 will 
burn virtually any DVD or CD format, including Dual Layer. 
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Installing PrintWrite 2 
Installation of PrintWrite 2 will differ slightly 
for the Local Client and Remote Client.  
Regardless of the Client type, installation is 
performed using the PrintWrite 2 Installation 
Disc included with your Disc Publisher.  In 
both cases, installation begins with inserting 
the installation disc into a drive on your PC.   
If the Installer does not open automatically, 
use Windows Explorer to browse to the drive 
and double-click MBInstall.exe. 
Both Local Client and Remote Client 
installation will require you to reboot your PC 
after the installation completes. 

System Requirements 
Supported Operating Systems 

64-Bit: Windows 7 and Vista 
32-Bit: Windows 7, Vista, and XP with SP2.  

Processor 
Intel Core2 Duo or equivalent.  

System Memory 
Minimum 2 GB of system memory.  

Hard Drive Space 
Approximately 180MB of free space is required on the system hard drive for the applications 
and drivers.   
A separate internal 7200 RPM hard drive is recommended for storing your data.  Using the 
same hard drive as the operating system can cause the system to perform slowly. 

USB Connection 
USB 2.0 is required.   

Windows Component Prerequisites  
During the installation process, your PC will be checked to determine if required Microsoft Windows 
components are present.  If not, these components will be installed.  You cannot continue the 
installation without installing these necessary Microsoft Windows components.   
After the Prerequisite installation completes, you will be prompted to reboot your PC.  If you are 
instructed to reboot, you must do so before the installation can continue.  After rebooting, the 
Installer will automatically restart.   
 
If your PC has the Windows User 
Account Control (UAC) turned On, you 
will see the notice to the right appear.   

 
Double-click the tooltray icon indicated and 
select Run blocked Program.  Click the 
MBInstall entry as shown to the right to re-
launch the Disc Publisher installer. 
 



 
 
8 

PrintWrite 2 Software Re-Installation 
It is recommended that you uninstall PrintWrite 2 prior to reinstallation! 
There are 2 methods of reinstalling the PrintWrite 2 software should the need arise: 

A. The Disc Publisher installers are also located on the Installation CD.  To manually reinstall 
PrintWrite 2, browse to the Applications\PrintWrite 2 directory on the Installation CD and 
run setup.exe (32-bit) or setup_x64.exe (64-bit) to reinstall PrintWrite 2 manually.   

B. The PrintWrite 2 Disc Publisher software installer was also added to your hard drive in the 
event that you need to reinstall but do not have access to the Installation CD.  Browse to 
the C:\Program Files\Microboards\PrintWrite 2 for Remote Client\Applications 
directory on your hard drive and double-click setup.exe (32-bit) or setup_x64.exe (64-bit) 
to reinstall PrintWrite 2.   

Local Client Installation and Configuration 
For Local Client installation, which includes the installation of the hardware as well as the software, 
select the Microboards Disc Publisher model you will be connecting to your PC from the list 
provided and click the Install button that appears.  The Microboards Disc Publisher installation that 
will be launched will include the necessary hardware and software installations needed for use as a 
Local Client.   
Installation of both PrintWrite 2 and the Disc Publisher should be performed by a user with full 
administrative rights.  Under some scenarios, a non-administrative user can install PrintWrite 2, but 
there may be access issues for other users on the PC.    

Windows Vista and Reboot Requirements 
After connecting the hardware to a PC running Windows 
Vista as the Operating System, you may be presented 
with a dialog notifying you of a required reboot, as shown 
to the right.   
Click the Restart Later button if this dialog appears.  
There will be a required reboot at the very end of the 
installation process, after the Disc Publisher software is 
installed. 

 
 
 
 
 
You should select the reboot option only when 
the reboot request as shown to the right 
appears after the Disc Publisher software 
installation is complete. 
 
 
 
 
 

Windows Firewall Exceptions 
As part of the installation, you will be asked if you want to add Ports 10450 and 10451 to the 
Windows Firewall Exception list and allow access through these two ports.  These ports must 
be made accessible on your PC for a Remote Client to successfully connect to the Disc 
Publisher. 
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If you choose to not allow access to these ports, the Exceptions will be added to the list but in a 
disabled state.  This will allow you to allow access to the necessary ports easily should you decide 
at a later time to allow Remote Client access to your Disc Publisher.  
Additionally, it is recommended that File and Printer Sharing be allowed in the Firewall.  You may 
experience connection difficulties if this firewall setting is not set to allow access. 
Allow your PC to reboot as the last step in the installation process.  If you do not reboot your PC, 
PrintWrite 2 will not function correctly. 

 
Local Client Hardware Configuration 
After your PC has rebooted, the Publisher Configuration 
window will appear.  In most cases the Disc Publisher 
drive(s), printer, and COM port will have been auto-
detected and will be entered into the configuration.  
Verify that the hardware has been correctly selected by 
clicking the Test button next to each selection.  If the 
drive opens and closes, the printer runs, and the disc 
elevator lifts and drops, the selections are correct.  Click 
the OK button. 
If the Test buttons do not operate the correct hardware 
component (example: a DVD drive other than in the 
Disc Publisher responds to the test) select the correct 
hardware from the list and retest before clicking OK.   
The Configuration Window will appear even if 
PrintWrite 2 is not launched. 

 
Allowing Remote Client Access 
Before any Remote Clients can connect to your Disc Publisher, you will need to Share the 
Publisher.  To do so, launch PrintWrite 2 and select Administrator from the Utilities menu.  Place 
a check in the Share Publisher checkbox and click OK.  Please refer to Administrator Utilities on 
page 19 for more information and options available to Sharing the Publisher.  See also 
Requirements to Allow Remote Client Connection on page 36. 
If you will not be allowing Remote Client access to your Disc Publisher, you will not need to make 
any changes to the Share Publisher setting. 
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Remote Client Installation and Configuration 
To install and configure PrintWrite 2 for Remote Client use, where the PC on which you are 
installing PrintWrite 2 is not connected directly to the Disc Publisher, select PrintWrite 2 for 
Remote Client from the Product for Installation list.  This will install PrintWrite 2 and SureThing 
Disc Labeler only, as the hardware installation is not needed to operate as a Remote Client. 
After the installation is complete and your PC has been rebooted, 
launch PrintWrite 2 using the icon on the desktop.  The Remote 
Connection selection window will open, as shown to the right. 
 

 
Click the Scan button to automatically scan within the same network 
Gateway for available Disc Publishers on your network that can be 
accessed by a PrintWrite 2 Remote Client.  This will return the PC 
names or IP Addresses of any PC on your network that is currently 
running the PrintWrite 2 remote services as a Local Client.  The 
PrintWrite 2 Publisher services do not run on Remote Client PCs, so 
those PCs will not be detected by the scan. 
NOTE:  The scan process may disconnect or interfere with other applications running on your PC 

that require continual network communication with a specific host server.  It is 
recommended that you perform the Remote Connection scan with no other applications 
running. 

The Scan process will take a few minutes, with the progress of the scan being displayed in the 
progress bar to the right of the button.  Once complete, the Remote Servers Found drop-down list 
will be populated with the names or IP Addresses of the Local Client PCs found on your network.  
Select the correct Local Client PC name or IP Address and click the OK button. 
 
Alternately, you can manually enter in the Local Client PC name or IP 
address without using the scan.  Click the Manual IP Entry button 
and enter in either the PC Name or the IP Address of the Local 
Client PC that you want to use as the PrintWrite 2 Remote Server.   
NOTE: If your network domain configuration uses DHCP to assign 

dynamic IP Addresses to the PCs on your domain, it is 
recommended that you enter in the PC Name rather than the 
IP Address as the Remote Client will no longer have access 
to the Disc Publisher if the Local Client IP Address is 
changed by your domain server. 

Click the OK button when you have entered in either the PC Name or IP Address of the PC that is 
configured as the Local Client.  This will return you to the Remote Connection window with the 
manual entry you made in Remote Servers Found.  Click OK to complete the connection process. 
 
After you have selected the correct Local Client PC, PrintWrite 2 will connect your PC as 
a Remote Client to the Disc Publisher.  It may take a minute or two for the connection to 
be completed.  Once the connection is made, an image of the Disc Publisher will appear 
in the Publisher Information button on the top right of the main PrintWrite 2 window.   
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PrintWrite 2 and Non-Administrator Users 
You can configure the PC to allow non-administrator users to run PrintWrite 2 on your Local Client 
PC.  To perform these steps, you will need to be logged on to your computer as an administrator. 

Sharing the PrintWrite 2 Working Directories 
For non-administrator users to run PrintWrite 2 on your PC as Local Clients, the two working 
directories for the application must be shared.   
One of the directories, C:\MBSDK Data, will not exist until PrintWrite 2 is launched for the first time. 
Depending on the security level set on your PC, you may also need to share directories from which 
users are selecting files or print images. 
Sharing the directories is not necessary to allow 
Remote Clients to connect to your Disc Publisher. 

Windows XP  
The first directory that must be shared is the directory 
in which PrintWrite 2 was installed.  By default, that 
directory is C:\Program Files\Microboards\PrintWrite 
2.  If you changed the installation location, you will 
need to share the directory to which you installed 
PrintWrite 2.   

1. To share the directory, open Windows Explorer 
and right-click the PrintWrite 2 installation 
directory.   

2. Select Sharing and Security from the drop-
down menu. 

3. Place a check in the Share this folder on the 
network and Allow network users to change 
my files controls, as shown to the right.   

4. Click OK to save the sharing changes. 
Use the same process described above to share the working directory for PrintWrite 2, which is the 
C:\MBSDK Data directory.   

Windows Vista and Windows 7 
To allow sharing in Windows Vista or Windows 7, you must share the C:\MBSDK Data and the 
C:\Program Files\Microboards\PrintWrite 2 directory, as in Windows XP.  The steps are a little 
different, however, if Windows UAC is on.  

MBSDK Data directory 
1. To share the C:\MBSDK Data 

directory, browse in Windows Explorer 
to the C: drive. 

2. Right-click the C:\MBSDK Data 
directory.  Select Sharing… from the 
menu that appears. 

3. To share with all users, select 
Everyone (All users in this list) from 
the drop-down list, then click the Add 
button. 
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4. To share with specific users only, select the 
user name from the list and click Add.  If you 
want to add multiple users, you will have to 
select each user individually.   

5. All users added will by default have only 
Reader access to the directory.  To change the 
access level, click the Permission Level entry 
for the user you just added, and select Co-
owner. 

6. Click the Share button to complete the process 
for sharing the C:\MBSDK Data directory. 

 
PrintWrite 2 directory 
Sharing the PrintWrite 2 directory requires a slightly different process from the MBSDK Data 
directory. 

1. Start by browsing in Windows Explorer to the location to 
which you installed PrintWrite 2.  By default, this location is 
C:\Program Files\Microboards\PrintWrite 2.   

2. Right click the directory and select Sharing… from the menu. 
3. Click the Advanced Sharing button in the window that 

appears. 
4. In the next window that appears (shown to the right), place a 

check in the Share this folder setting.   
5. Click the Permissions button to set the access level for all 

users. 

 
 
 
 

6. Place a check in the Full Control permission in the Allow 
column.  This will fill in the Change permission as well. 

7. Click OK to complete the sharing process.  Click OK in all 
other windows that are open. 
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PrintWrite 2 and Firewalls 
In order to allow Remote Clients access to the Disc Publisher connected to the Local Client PC, the 
Firewall settings on the Local Client PC may need to be modified.   
Always discuss any Firewall setting changes with your Network Administrator. 

Windows Firewall 
If you have the Windows Firewall set to Off on the Local Client PC, you will not need to make any 
changes to the security settings. 
 
The easiest way to add the applications to the 
Windows Firewall program exceptions list is to 
simply launch PrintWrite 2 when logged in as an 
administrator.  If your PC has Windows Firewall 
active, you will see the window to the right.  
Clicking the Unblock or Allow Access button will 
add Server Manager to the exceptions list, 
allowing this necessary PrintWrite 2 process to run. 
 
In addition to the Server Manager, two ports will 
need to be opened to allow communication 
between a Publisher installed on your local PC and 
any remote PC you will be allowing to access your 
Publisher.   
 
If you installed your Publisher using the Installation 
Disc provided by Microboards, one of the questions 
you are asked during the installation is if you want 
to open Ports 10450 and 10451.  If you answered 
Yes, those ports were added to the Exceptions list 
and opened, and you will not need to do anything 
further.  
 
 If you answered that you did not want those ports opened, the ports were added to the exceptions 
list but were not opened.  You will need to open the Windows Firewall interface and manually open 
the two ports if you want to be able to have other PCs connect to the Publisher on your PC. 

For Windows XP and Vista: 
1. Select Windows Firewall from the Control Panel  
2. Click the Exceptions tab.   
3. Scroll down the list until you see PrintWrite Port 10450 and PrintWrite Port 10451.  These 

exceptions must be checked for Remote Clients to access the Disc Publisher.   
4. Click the OK button after checking these two exceptions. 

For Windows 7:  
1. Open the Windows Firewall in the Control Panel.   
2. Click the Advanced Settings link in the left column.   
3. In the next window that opens, click the Inbound Rules link and locate the entry PrintWrite 

Inbound.   
4. Right-click PrintWrite Inbound and select Enable Rule from the options that appear.   
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5. Click the Outbound Rules link and locate the entry PrintWrite Outbound.  Right-click 
PrintWrite Outbound and select Enable Rule from the options that appear.   

6. Close the Windows Firewall windows. 
7. In addition, File and Print Sharing should be allowed to avoid possible connection issues 

that can be seen if File and Print Sharing is blocked by the Firewall. 

Non-Windows Firewall Applications 
If you are using a Firewall application other than Windows Firewall, you may need to manually add 
the application ServerManager.exe to the firewall exceptions list after installing PrintWrite 2.  
ServerManager.exe will be located in the Program Files\Microboards\PrintWrite 2 directory. 
If you plan on allowing other PCs to send publishing jobs remotely to your Publisher, you will also 
need to add and open Ports 10450 and 10451 as TCP ports to your firewall application exceptions 
list.  Additionally, File and Printer Sharing should be allowed to avoid possible connection issues. 
Please consult your firewall application documentation or your Network Administrator on how to 
make these necessary changes to the Firewall configuration. 
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 PrintWrite 2 Menus and Toolbar 
Double-click the desktop icon that was created during installation of the software.  If the Hardware 
Configuration screen appears, verify the configuration, enter in the name you would like to use for 
the Disc Publisher, and click OK, as described on Page 9.  This will only occur if you are configured 
as a Local Client, with the Disc Publisher connected directly to your PC.  
The main PrintWrite 2 window includes all of the controls necessary to create, submit, and save 
Disc Publishing projects.  The interface includes various Label Controls that affect the label 
selection, a Recent Labels Library that shows the last 20 labels used in PrintWrite 2 projects, a File 
Selection List with controls to manipulate the list, and the Project Submission controls.   

 
The Toolbar and Menu functions will be discussed first.  Then steps that are common to multiple 
Project Types will be covered, followed by specifics for each individual Project Type. 

 

Recent 
Labels 
Library 

File Selection List 

Label 
Controls 

Submission 
Controls 



 
 
16

The Toolbar 
There are 5 functions that can be accessed using the Toolbar at the top of the main window, just 
below the menus. 

Job Options 
Please see Common Project Steps: Job Options, page 23.   

New Project 
Clicking this button will clear out the project you are currently designing.  This will not affect any 
jobs already submitted.  This function is also available in the File menu. 

Open Project  
You can click this button to open any previously-saved project from PrintWrite 2.  Opening a 
saved project will replace anything you already have designed in the main window. This function 
is also available in the File menu. 

Save Project 
Click this button to save the project currently showing in the main window. This function is also 
available in the File menu.     
Once a project has been saved, you can re-open it by selecting Open Project in the File menu, 
or by clicking the Open button in the Toolbar.  Either of these methods will display the project 
design to give you the opportunity to review the project before submitting the job. 

Publisher Info 
Click the button showing the Publisher model you are currently 
connected to, located on the far right side of the toolbar, to open the 
Publisher Information drawer.  The drawer will open to the right of the 
main window, and will close the Job Options drawer if open. 
The Publisher Status section shows the name of the publisher that you 
are currently connected to, as well as the State and specified Media 
Type.  If you are accessing a Publisher remotely, the amount of space 
available on the server hard drive will be displayed as well as the 
connection type and the name or IP address of the server. 
For the MX Disc Publisher models, each ink color has an individual 
cartridge.  All four ink levels will be displayed. 
For the CX Disc Publisher model, the black and color ink cartridge 
levels will be shown separately, as shown to the right.   
For the G3 Disc Publisher, which only has a color composite ink 
cartridge, the level will show the percentage remaining of the single 
cartridge.   
The composite color cartridge ink level for the CX and G3 Disc Publishers will be determined by 
which of the three colors has the least amount of ink remaining.  If the composite cartridge is 
almost empty of yellow, for instance, the ink level displayed will be that of the yellow ink.  
Because of this, your composite cartridge may not feel empty, by weight, when the ink level is 
reporting as empty. 
Color composite ink cartridges cannot continue to be run if any of the three colors of ink are 
empty. 
If you are connected to a Disc Publisher as a Remote Client, the amount of available hard drive 
space on the Local Client PC will also be displayed.   

The File Menu 
The File menu has four options: New, which will clear the current project settings to begin a new 
project; Open, which will allow you to select a saved PrintWrite 2 project; Save, which will save the 
setting for the project currently showing, and Exit, which will close PrintWrite 2. 
New, Open, and Save operate the same as using the Toolbar items of the same names described 
above. 
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The Utilities Menu 
The Utilities menu includes the Remoting Utilities, Publisher Utilities, Administrator, Remote 
File Location, and PrintWrite Utilities menu items. 
Some of the menu items in the Utilities menu and some of the individual settings within the Utilities 
menu items will only be available if you are using a Disc Publisher connected directly to your PC. 

Remoting Utilities 
The Remoting Utilities menu item allows you to 
connect to a Microboards Disc Publisher that is running 
on a different PC.   

Local Publishing 
If your Disc Publisher is connected directly to the PC 
you are using, all you will need to do is set the 
Connection to Local and click the OK button.   
If you installed your Disc Publisher, drivers, and 
software using the MX, CX-1, or G3 Disc Publisher 
Installation, the Connection will by default be set to 
Local.  You will not need to make a change to this 
setting.   
When the Remote Connection is set to Local, the 
Scan and Manual IP Entry buttons as well as the 
Remote Servers Found drop-down list will not be 
available. 

Remote Publishing 
If your Disc Publisher is connected directly to a PC 
other than the one you are using, you will need to set 
the Connection to Remote.   
If you installed PrintWrite 2 for Remote Network Client, the Connection will by default be set to 
Remote.  You will not need to make a change to this setting, but you will need to select the 
Remote Server before you will be able to use the Disc Publisher on another PC. 

Scan 
Click the Scan button to search the listed Available Gateway for active PrintWrite 2 Local Client 
PCs.  The scan may take up to a few minutes to complete; the progress bar to the right of the 
button will show how far the scan has gone. 
Once the scan is complete, all Local Client PCs currently running the PrintWrite Server Services 
will appear in the Remote Servers Found drop-down list. 
Please note that all of the Local Client PCs listed may not have the Share Publisher setting in the 
Administrator Utilities turned on to allow Remote Client connectivity. 

Manual IP Entry 
If you know the IP address or name of the PC to which you want to connect, you can use this 
button to access a dialog that will allow you to specify the PC you want to connect to without 
running the Scan. 
After entering in either the PC Name or the IP Address (you do not need to enter both), click the 
OK button.  The information you entered will appear in the Remote Servers Found drop-down 
list. 
NOTE: Once you have scanned or entered a PC in manually, you will not need to perform either 

process again unless there is a change in the location of the publishers on your network, or 
if the IP addresses of the Publisher servers change. 

Remote Servers Found 
After either scanning the network or entering in the PC name manually, select the PC to which 
you want to connect for remote disc publishing.   
Click the OK button when your Connection settings are correct. 
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The Publisher Info button on the right of the main window will change to represent the Disc 
Publisher model that is available for remote disc publishing.  Click the button to view the 
Publisher status drawer. 
There may be a short time period during which the Publisher Info State will show as Changing 
Publisher or Connecting.  It may take a few minutes for the connection process to complete.  If 
the connection is not completed within a few minutes, there may be a setting incorrect on the 
Local Client PC or the Disc Publisher itself may not be ready to publish.   
While you can change from one remote publisher to another, there will be times in which you will 
be unable to do so and the controls will not be visible on the Remoting Utilities dialog.  An 
example of when you will not be able to change publishers is when files are being transferred 
from your PC to the Remote Server after submitting a project. 

Publisher Utilities 
The Publisher Utilities menu item gives you access to a number of utilities.  The utilities that are 
available will depend on whether the Connection setting is Local or Remote. 

Stop/Start Server Manager  
(Local Client only) 

Click this button if you need to stop the 
local Server Manager.  Note that doing so 
will cause any currently active jobs to fail. 
Once you have stopped the Server 
Manager, some of the buttons will no 
longer be available. 

Offline/Online (Local Client only) 
Click this button if you need to take the 
Disc Publisher Offline for any reason.  
Doing so will cause any active job to fail. 
When the Publisher is in an Offline state, 
the Diagnostics utility will not be available. 

Diagnostics (Local Client only) 
Click this button if you want to run a configuration diagnostics on the publisher.   
This will cause any jobs currently active to fail. 

Restart Services 
Click this button to stop and restart the PrintWrite Services.  Any of the services that were already 
stopped will be restarted.   
Restarting the services will cause any jobs that are currently active to fail. 
Note that if you are accessing a remote Disc Publisher, the number of PrintWrite Services listed 
will be fewer than if you are running your Disc Publisher locally. 

Stop Services 
Click this button to stop the PrintWrite Services that are currently running.  The services affected 
will depend on whether the Connection is set to Local or Remote. 
Stopping the services will cause any jobs currently active to fail. 

Purge Print Spooler 
Click this button if you need to clear all print jobs from the Windows Print Spooler.  This will affect 
all currently printing jobs on all printers on the PC. 

Help 
Click this button to open the help page specific to the Publisher Utilities. 

Status Messages 
The Status Messages list on the right will show the most recent activity on the Publisher.  This list 
will appear regardless of the Connection setting. 
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Administrator Utilities  
The Administrator Utilities menu item is only available when you 
are performing Local Disc Publishing.  The settings in this menu 
option affect whether or not remote users can connect to the local 
Disc Publisher, as well as assigning a default media type. 

Share Publisher 
Check this box to allow Remote Publisher Clients to access the 
Local Disc Publisher.  If the box is not checked, Remote users 
cannot submit jobs using PrintWrite 2 to the Publisher 
connected to your PC. 
Changes to this setting will trigger a notification message to all 
users connected to your PC running the PrintWrite 2 Monitor. 

Edit Client Lists 
Use the Edit Client Lists button if you want to specify which computers can access the Local 
Disc Publisher or if you want to specifically restrict some PCs from connecting to the publisher. 
The Client List has two sections, one for specifying those PC names or IP Addresses that are 
Allowed to connect and those that are Blocked from connecting.   
If you leave both the Allowed and Blocked lists empty, there will be no restrictions on which PCs 
on your network can connect to your Disc Publisher when Sharing is enabled. 
If you add PC names or IP addresses only to the Allowed list, PrintWrite 2 will only allow those 
PCs to connect to the Publisher.  By using only the Allowed list, you will not need to specifically 
block other PCs. 
Alternately, if you add PC names or IP addresses only to the Blocked list, any PC on your 
network except for those specified will be able to connect to your Disc Publisher.  By adding 
entries only to the Blocked list, you are specifying only those PCs that are not allowed access to 
the Publisher. 
If you have entries in both the Allowed and Blocked lists, only those PCs in the Allowed list will 
have access to the Publisher unless the PC name or IP address is also in the Blocked list.  For a 
PC to be able to access the Publisher, the name or IP address can only be in the Allowed list. 
The following chart illustrates these settings: 

  
 

 
 
 
 
 
 
 

 
Use the Add Allowed or Add Blocked buttons to add a PC name or IP address to the Allowed 
or Blocked lists.  To remove a PC name or IP address from the Lists, highlight the entry you want 
to remove and click either the Remove Allowed or Remove Blocked button, depending on the 
list you are changing. 

Media Type 
This setting allows you to specify the type of media that is currently loaded into your Disc 
Publisher, allowing Remote Users to know what type of projects they can submit.  
If you have a specific media type selected, any user connected to the Publisher will be notified if 
they select a project type or disc image media type that does not match the Media Type specified 
here.  Notification will also occur when the project is submitted.   

 Allowed Blocked Result 
Example 1 Empty Empty All PCs on network have access 

Example 2 PC_Graphic Empty Only PC_Graphic has access 

Example 3 Empty PC_Graphic All PCs have access except  PC_Graphic 

Example 4 PC_Graphic 
PC_Video 

PC_Graphic 
Only  PC_Video has access 
PC_Graphic does not have access 
No other PCs have access 
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Users will have the option of submitting the project anyway, allowing for a quick, temporary 
change of media loaded in the Publisher without alerting all users that the media type has 
changed.  However, submitted jobs that are dependent on the media type actually loaded into the 
Publisher will fail if the media is not compatible with the job submitted; for instance, submitting a 
Data CD job to a Publisher loaded with DVD media will result in a failure.  
Please note that setting the Media Type to BD will not give your publisher the ability to burn to 
Blu-Ray media unless you purchased a Publisher with that capability. 
Select Any Media if you do not want to specify the media type. 
Changes to this setting will cause the PrintWrite 2 Monitor to deliver a pop-up notification 
message to all connected users. 

OK and Cancel 
Click the OK button to save any changes and return to the main PrintWrite 2 window.  Click 
Cancel if you do not wish to save any changes you may have made. 

Transfer File Location 
During Disc Publishing from a Remote Client PC, data and print image files are transferred onto the 
Local Client PC hard drive.  By default, the files are transferred to C:\Temp Data Files and print 
images are transferred to C:\Temp Print Files.  Although the files are deleted from the server hard 
drive once a job completes, files from multiple submitted projects can reside on the hard drive at 
any given time, making hard drive space on the server a concern. 
If you do run low on space on the C: drive of the server, use the Transfer File Location settings to 
change the location of these temporary files to another drive.  The amount of available space 
necessary will depend on the types of projects that are submitted and the number of projects that 
are submitted in close succession.   
The locations for both the transferred data and print files should be dedicated for the transfer of files 
from Remote Clients to the Local Client PC only as maintenance on the contents of these 2 
directories will regularly occur and will remove any files not in use by PrintWrite 2.  
These file locations are only used if Remote Clients are being allowed to operate your Disc 
Publisher.  If you are operating your Disc Publisher from a Local Client configuration only, these 
settings will not be used. 

View Log Files 
The View Log Files function allows you to review the most current 1000 lines of each of the log files 
generated by PrintWrite 2.  This function will only create a snapshot of the log files at the time they 
are selected and is not intended to be used to monitor the ongoing processes live. 
For a Local Client, there will be seven log files available for viewing.  A Remote Client will have only 
3 log files available, as the remaining four are used for local publishing only. 

PrintWrite 2 Email Utility 
As part of the PrintWrite 2 installation, the PrintWrite 2 Email Utility is installed on your PC.  
This utility, which can be accessed though the Programs menu using the Start button, will 
automatically compress and email the current PrintWrite 2 log files to a Microboards Technical 
Support email addresses, which can be selected based on your location.   
The available options are to email the files to the US Tech Support, UK/European Tech Support, 
or Japan/Asian Tech Support.  Enter in your email address so a response can be sent to you, 
along with comments on the specifics of the problem you are seeing. 

PrintWrite  
The PrintWrite Utilities menu includes a number of functions that are related to the configuration 
and operation of PrintWrite 2.   

Reset Hardware Configuration (applies to Local Client only) 
If the hardware configuration on your Local Client PC has changed – for instance, you are 
changing the model of Disc Publisher that is connected to the Local Client PC – you will need to 
use this utility to perform a reset of the hardware configuration.   
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After selecting Reset Hardware Configuration 
from the PrintWrite menu, select the Disc 
Publisher Model Family to which you want to 
reset the configuration and click the Reset 
button.   
Once done, shut down PrintWrite 2 and reboot 
your PC.  After the PC reboots and the PrintWrite 
Publisher Services launch, the Hardware 
Configuration window will appear.  Please refer 
to Local Client Installation and Configuration : 
Hardware Configuration on page 9 for more 
information on selecting the drives, printer, and 
COM port. 
 
You must reboot your PC after resetting the 
hardware configuration! 
 
If there are any Remote Client PCs connected to the Local Client PC on which the hardware 
configuration changes, the Publisher Information will show the Disc Publisher as Unavailable, 
and the Publisher Info button will change to a red background.  Once the new Hardware 
Configuration is initialized, the Publisher Info on the Remote Clients will show that the Publisher is 
ready. 

Enable Submit 
The Submit button can be hidden or disabled in some circumstances, such as if the Disc 
Publisher is offline or during Batch Copy.  This is intended to keep job submission failures to a 
minimum. 
If the button is not available, use this option to show the Submit button again.  If the Enable 
Submit option is not available, the Publisher is in a state that will not allow submission of 
projects.   
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View Menu 
The View menu options allow you to change the appearance and behavior of the Recent Labels 
Library in the main window.   

Disc Label View 
The Recent Label View option allows you to switch 
between the 2 available formats for the Recent Label 
Library.  The available formats are Horizontal and 
Carousel, with Carousel being the default view. 

Auto Open Publisher Drawer 
Toggle this setting On or Off to control whether or not the Publisher Drawer opens automatically 
when PrintWrite 2 is launched.   

Auto Open Job List Drawer 
Toggle this setting On or Off to control whether or not the Job List Drawer opens automatically 
when a project is submitted.   

Help Menu 
The Help menu links you to the Help files that are included with the PrintWrite 2 installation. 

PrintWrite Monitor 
The PrintWrite Monitor application, which will appear as an icon in 
the tooltray, can be used to check the status of the PrintWrite 2 
services.   
The Monitor is an independent application that can provide you with information about the Disc 
Publisher state, PrintWrite 2 Service status, and recent information on what operations PrintWrite 2 
has been performing. 
The Monitor also provides pop-up notifications on changes of Publisher status regardless of what 
PrintWrite 2 may be doing.  
 
To open the Monitor, either double-click the icon in 
the tooltray or give the Monitor icon a right-click 
and select Show PrintWrite Monitor from the 
menu that appears. 
 
 
 
 
 
 
 
 
 
 
In addition to the right-click Show Monitor selection, you can 
toggle the notifications On or Off, Hide the Monitor, or 
Close the Monitor altogether.  Closing the Monitor window 
using the X button in the upper right corner will not shut 
down the monitor, only close the visible window. 
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Creating Projects 
Common Project Steps 

While the steps in building each project may differ from project type to project type, there are many 
steps that are the same from project to project.  Those steps are detailed here, with references 
back to this section when describing the steps for each specific project type. 

Selecting the Project Type 
Use the Project Type drop-down at the top of the PrintWrite 2 window to select the correct project 
that you want to create.  Please note that some of the project types listed will only be available if the 
Disc Publisher you are using is connected directly to your PC.  Everything you will need to create 
that project type will appear on the screen.   

Setting the Disc Name 
Simply enter the name you want to assign to the disc in the Disc Name field.  This name will 
appear in Windows Explorer when the disc is inserted into an optical drive.   

Adding Files to Record 
In almost every project type, you will need to select the files you want to record.  Project types that 
include selecting the files to record and the files that can be selected are:  

Project Type Selectable items 
Audio CD .wav, .wma, and .mp3 files  
Data Disc, all media formats Any file or folder 
Video Disc Authored Video Directory (typically, Video_TS) 
Burn Image .di or .iso files only  

Adding Files  
Add files to any files selection list by clicking the Add button.  Use the file browser to navigate 
to your hard drive and select your files or folders. 

Removing Files 
Once the file selection has been made, the Remove button is enabled.  This button will 
remove the highlighted item or items in the file selection list. 

Drag-and-Drop, Copy-and-Paste Files 
You can add files by using the Drag-and-Drop 
feature.  Simply highlight files or folders in Windows 
Explorer and drag their icons into the file selection 
list.  You can also Copy and Paste files from 
Windows Explorer into the file selection list. 
If there are more files in the list than can be shown on the main window, vertical scroll bars will 
appear on the right side of the file list. 

Selecting a Label to Print 
With the exception of Stream projects, you can select the label you want to 
print either by dragging the label’s image file into the Recent Label Library 
or by clicking the Choose… button and selecting the label.   
Additionally, you can also select a label from the Recent Labels library, 
which will store the last 20 labels that you have used for previous projects.  
To select a label from the library, scroll through the label images until the one 
you want is in the front and double-click the image. 

Supported Image Formats 
PrintWrite 2 requires the use of label files created by the SureThing Disc 
Labeler software, which is included with the PrintWrite 2 installation.  Label 
files that can be selected will have a .std file extension.  
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Label Settings 
Different types of media have different Inner and Outer diameters for the printable surface.  You 
can select from a number of pre-defined printable media brands and types, or define your own 
custom types.  This allows you to quickly change media types between projects.  Click the Label 
Options button to make any necessary changes.  
 
 
To define your own custom media dimensions, select Add Custom 
Settings from the Disc Type list.  Diameters are given in 1/10th millimeter 
increments. 
 
To save your settings as a new defined media type, enter in a name 
under which to save the settings in the Custom Name and click the Save 
Setting button.  Your media type is now added to the Printable Media 
Type list.  You do not need to save custom settings to use them, but 
custom settings that aren’t saved will only be available until you select a 
different diameter setting or you close PrintWrite 2. 

Selecting the Number of Discs 
If you will be creating more than one disc from a project, adjust the entry in the 
Number of Copies field accordingly.   

Job Options 
Several of the project types have Job Options that can be modified.  
The default settings will be applicable to virtually all needs; unless you 
have a specific reason to do so, there is no need to change any of the 
settings.   
To view the Job Options, click the Job Options button in the main 
window or the Job Options button in the toolbar.  The Job Options 
window will appear over the main PrintWrite 2 window. 
If you need to change any of these settings, it must be done before the 
job is submitted.  Changes to these settings will not affect jobs already 
in the Job List. 
Not all settings will apply to all project types.   Job Options that cannot 
be modified for a given project will not be visible. 
The Print Only Project type does not include any modifiable Job 
Options. 
Recording Mode (Applies to Data Disc projects only) 

Available options are Open and Closed.  By default, Closed is the 
selected setting.  By selecting Open, the recorded disc can later have 
data appended to it while a Closed disc can not. 

Recording Type (Applies to Data Disc projects only) 
Available options are Disc and Once and Track at Once.  The 
default setting for each project type is always recommended.     

Write Speed (All burn projects) 
Available options are Maximum, Medium, and Minimum.  The default setting is Maximum. 
The exact burn speeds of each will depend on the drive model and type of media used for the 
project. 

Verify Disc (Data Discs, DVD Video, and Burn Image projects) 
Placing a check in the Verify Disc option will read and compare the copies to the master disc or 
source files as each disc completes the burn process.  Selecting this option will increase the 
amount of time it takes to process each disc.  You cannot combine Test Burn with Verify Disc. 



MICROBOARDS TECHNOLOGY, LLC                                                                                               PrintWrite 2 for PC 

  25

Test Simulate Burn (All burn projects) 
Use this option if you want to test the functionality without burning to a disc.  This setting will not 
apply when burning a DVD Video ISO image protected by VideoWrite.  
Some media, such as DVD+R, cannot be used in Simulate mode.  Using this option will result in 
rejected discs and a failed job. 

Create Temporary Image (All burn projects except Batch) 
This option allows you to create a temporary image from which the copying will occur rather than 
burning directly from your original files.  While this will add to the amount of time it takes to 
complete the project, it does reduce the possibility of burn failure. 
By default, this option is unchecked for all applicable projects except for the Copy Disc project.  
For the Copy Disc project, this option will be checked and is the same as Create Temporary 
Disc Image setting below the Source Drive information (page 26).   

This option will be checked and cannot be changed for any applicable burn project 
using a 2-drive Disc Publisher in which both drives are enabled and the number of 

discs being burned in the project is greater than one. 
PreGap, Album Title, Album Arist (Audio CD projects only) 

These 3 settings are only available in Audio CD projects. 
 

 Copy 
Disc 

Audio 
CD 

Data 
Disc 

Video 
Disc 

Print 
Only 

Batch 
Job 

Burn 
Image 

Create 
Image 

Erase 
Disc 

Recording Mode        

Recording Type       

Write Speed       

Priority    

Verify Disc        

Test, Simulate 
Burn          

Create Temp 
Image Files          

Pre-Gap         

Album Title         

Album Artist         

Submitting a Job 
Once you have the correct project type and have completed building the project, 
load the correct media type for your project and click the Submit Job button. 
Always load your media prior to clicking the Submit Job button, as the publisher may begin to load 
immediately. 
If you are configured as a Local Client, with the Disc Publisher connected directly to your PC, the 
job will appear in the Job List. 
If you are configured as a Remote Client, the files you selected in the project will be transferred to 
the PC connected directly to the Disc Publisher, with the transfer progress being displayed.  Once 
the transfer is complete, the job will appear in the Job List. 
The progress of the currently active job will be displayed at the bottom of the main window.   

  

Project Types and Available Job Options 
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Copy Disc (Local Client Only) 
Master Selection 

Source Drive 
Use the Source Drive list to 
select the drive in which you 
have your master disc from 
the list of available drives.  
The information about the 
master below the drive list 
will appear once a drive has 
been chosen. 

Create Temporary Disc Image 
Placing a check in this box will cause PrintWrite 2 to extract a disc image from the master disc to 
use for burning.  You should use this setting if you are making multiple copies from one disc; it 
may add the time to create the disc image to your project, but it will eliminate any failed burns 
caused by read issues. 
You cannot mix master and blank disc types; for instance, you cannot burn to a DVD from a CD 
master. 

Select a Label to Print 
Use the Recent Labels Library or Choose button to select the print image you would like to use for 
your copies of this disc (see page 23). 

Select the Number of Copies 
Use the Number of Copies control to specify how many discs you would like to burn. 

Edit/Submit Project 
Click the Submit button to submit your project when you are ready to do so. 

Audio CD 
Adding Audio Files  

You will only be able to add audio files to 
this project type.   
Please see Common Project Steps: 
Adding Files to Record on page 23.  
The Track Number, Track Name, and 
Performer Track Title will be displayed. 
Changing Track CD Text 
Right-click a file in the list and select the 
option to Enter Performer and Track 
Title.  A window will open allowing you to 
enter Performer and Title information.  
Click the OK button when the information 
is complete to return to the main window. 

Select a Label to Print 
Use the Recent Labels Library or Choose button to select the print image you would like to use for 
your copies of this disc (see page 23). 

Select the Number of Copies 
Use the Number of Copies control to specify how many discs you would like to burn. 

Edit/Submit Project 
Click the Submit button to submit your project when you are ready to do so. 



MICROBOARDS TECHNOLOGY, LLC                                                                                               PrintWrite 2 for PC 

  27

Data CD, Data DVD, Data BD 
Select the Data Project Type that matches the media to which you will be burning.  Data BD can 
only be used if your Disc Publisher was purchased with a Blu-Ray drive. The capacity of the media 
will be determined by the media type selected. 

Adding Data Files 
Files or folders of any type can be added to a data project.   
Please see Common Project Steps: 
Adding Files to Record on page 23.  The 
File Name and the file Size will be 
displayed.  Any folder in the list will show 
the size of the contents of the folder.  

Select a Label to Print 
Use the Recent Labels Library or Choose 
button to select the print image you would 
like to use for your copies of this disc (see page 23). 

Select the Number of Copies 
Use the Number of Copies control to specify how many discs you would like to burn. 

Edit/Submit Project 
Click the Submit button to submit your project when you are ready to do so. 

Video  
The Video project type allows you to burn video content to the appropriate disc type. 

Adding Video Files 
Only the appropriate video folders can be 
added to a Video disc project.   
Please see Common Project Steps: Adding 
Files to Record on page 23.  The File Name 
and Size will be displayed.   

Select a Label to Print 
Use the Recent Labels Library or Choose button to select the print image you would like to use for 
your copies of this disc (see page 23). 

Select the Number of Copies 
Use the Number of Copies control to specify how many discs you would like to burn. 

Edit/Submit Project 
Click the Submit button to submit your project when you are ready to do so. 

Print Only 
The Print Only project type allows you to print to a disc without burning any information.   
This project type is useful if you have pre-burned discs.  You may also print prior to burning the 
discs, but in that case it is highly recommended that you allow the ink to dry fully before burning the 
disc in the disc publisher. 

Select a Label to Print 
Use the Recent Labels Library or Choose button to select the print image you would like to use for 
your copies of this disc (see page 23). 

Select the Number of Copies 
Use the Number of Copies control to specify how many discs you would like to burn. 

Edit/Submit Project 
Click the Submit button to submit your project when you are ready to do so. 
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Master 1

Master 2 Blanks

Batch Copy (Local Client Only) 
The Batch Copy project is the most automated of the project types, and can be used if you have 
more than one master that needs to be duplicated. 
Batch Copy is similar to Disc Copy, except all media including the masters are processed in the 
Disc Publisher. 

Loading Discs for Batch Copy 
Load the first master into the input hopper, then the number of blank discs you require.  Load the 
second master next, then place as many blanks as is necessary on top of the second master, and 
so on.  It is recommended that you load the first master and blanks, then select the correct print 
label for that master before loading the next set of master and blanks. 
In the example to the right, the gray discs 
are the masters and the white discs are 
the blanks.  Master 1 will first duplicate 
onto the 2 blanks discs loaded above it, 
and then Master 2 will be duplicated onto 
the 3 blank discs loaded above it. 
Each loaded master must have at least one blank disc to which it will be copied.  Loading 2 masters 
in a row will stop the Batch duplication 
After the Batch copy begins, the master will be loaded into the Disc Publisher and read to the hard 
drive.  Duplication of the master will come from this hard drive image and not directly from the 
master disc.   

Selecting the Labels to Print 
Unlike other project types, Batch Copy gives you the ability of selecting multiple labels.    
The labels must be in the same order in the list as the masters that have been or will be loaded into 
the Disc Publisher.  The master loaded first – on the bottom of the stack – will be associated with 
the first label in the list.  
Highlighting a single label file in the label selection list will provide a preview to the left of the list. 
You can populate your list of labels in a number of ways.   
Recent Labels 

Like on the standard Label to Print tab, you can choose your label from the Recent Labels list.  
Double-clicking an icon will show the label Preview; dragging an icon into the label selection will 
add that file to the list. 

Add Label button 
The Add Label button opens a browser so you can select the labels by looking through the drives 
available to your PC. 

Copy and Paste, Drag and Drop 
You can also use the Copy and Paste or Drag and Drop features of Windows Explorer to bring 
label files into the list. 

No Label 
Clicking the No Label button will add a blank “placeholder” for the 
selected master, indicating that discs duplicated from that master 
will not be printed after being burned. In the example shown, copies 
of Master 3 will not be printed. 

To the right of the list are the Add Label, Remove Label, No Label, Move Up, and Move Down 
buttons.  Clicking the Remove Label button will remove any highlighted label from the list.  Move 
Up and Move Down allow you to re-order the label files.  Remember, the labels will be printed in 
the order in which they appear in the list.  The number in the Master column will help you keep 
track of the correct order. 

Edit/Submit Project 
Click the Submit button to submit your project when you are ready to do so. 
Note that after submitting a Batch Copy job, you will be unable to submit 
further jobs until the Batch Copy job has completed. 
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Burn Image 
The Burn Image project type allows you to burn previously-created disc images.  Use this project 
type to add VideoWrite protection.     

Adding the Disc Image 
Only supported disc image formats can be added to a Burn Image project.  Supported image 
formats are .di and .iso. 
Please see Common Project Steps: Adding Files to Record on page 23.  
You can only select a single image per project.   
Images created by PrintWrite 2 (.di) will automatically select the 
correct disc type.  If the Disc Type selection appears, choose the 
correct Media Type for your selected image and click the Accept 
button.   

Selecting a Label to Print 
Use the Recent Labels Library or Choose button to select the print 
image you would like to use for your copies of this disc (see page 
23). 

Select the Number of Copies 
Use the Number of Copies control to specify how many discs you would like to burn. 

Edit/Submit Project 
Click the Submit button to submit your project when you are ready to do so. 

Using VideoWrite Copy Protection (Local Client Only) 
Windows 7 User Account Control must be off for the VideoWrite options to be available!! 

What is VideoWrite? 
VideoWrite allows you to copy protect your Video image files on your Microboards Disc Publisher 
from within PrintWrite 2, offering you protection for your video content.  Since the DVD Videos are 
copy protected, all production of these discs must be performed using PrintWrite 2 and your 
Microboards Disc Publisher. 
VideoWrite is only available if you are operating PrintWrite 2 as a Local Client. 
Your PrintWrite 2 installation comes with 10 free protected image burns.  Additional burns require 
the purchase of a VideoWrite USB Dongle.  Please contact your Reseller or Microboards 
Technology for more information. 

Creating a VideoWrite Protected Image 
The VideoWrite option within PrintWrite 2 allows you to copy protect any correctly formatted Video 
ISO file.  This option has been added to the Burn Image project, allowing you to quickly and easily 
perform the needed steps to protect the video DVD content you produce using your Microboards 
Disc Publisher. 
VideoWrite does not alter your original Video image file, but makes a protected copy of your file.  
While this allows you to retain the original file unchanged, it does require hard drive space on your 
PC.  As the Burn Protected File process also takes additional hard drive space, you should plan on 
having at least enough additional free space for twice the size of the original file.  For example, if 
you have a 4.35GB video ISO file you want to protect and burn, you will need an additional 8.8 GB 
of free hard drive space. 
If the .iso file you have selected is in the correct format for a Video image that has not been 
previously protected by VideoWrite and the VideoWrite USB Dongle is in place, the option to Copy 
protect the image file with VideoWrite will be available.  Click the button to begin the protection 
process. 
The available Burns on Dongle and Burns in Job Queue and 
the status of the ISO file will also be displayed.  In the example 
to the right, there are 277 burns remaining on the dongle, with 18 
VideoWrite discs currently in the Job Queue, for a total of 259 
burns available.  
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The Protection information will be displayed, showing the full path and name of the protected 
Output File (the word ‘Protected’ will be added to the name), the protected Output File Size (this 
will be larger than the original file), progress of the protection process, and the Start Protection 
button.   
Click the Start Protection button to create the protected file. 
The progress bar will show you how far along the protection process has come.  You can cancel 
the protection process by clicking the Cancel Protection button. 
Once copy protection is complete, the File 
Name will change automatically to that of the 
protected image file, the PrintWrite 2 window 
will show that the selected file is protected 
and the Copy Protection controls will be 
hidden. 
If the image file you originally selected is 
already protected, that information will be shown and you will not need to protect the file again.  The 
protected image file will automatically be processed using VideoWrite to create protected discs. 
After the Volume Name and Number of Copies are entered in, click the Start button to submit the 
project.  When using VideoWrite Copy Protection, you cannot burn more discs than you have 
Burns on Dongle minus the number of VideoWrite Burns in Job Queue.  If you cancel a job in the 
queue, only the completed burns are counted. 

Please note that any video DVDs protected and burned using VideoWrite protection will not 
be able to be duplicated, including in a Microboards duplicator.  All production must be 
performed using the VideoWrite protection on your Microboards Disc Publisher. 

Create Image (Local Client Only) 
There are 2 Create Image project types, one that uses files that already exist on your PC and one 
that creates an image from a burned disc using the optical drive in your Disc Publisher.  Either type 
allows you to store a master on your PC as a disc image.   
Only .di formats can be created using PrintWrite 2.   

Defining the Source 
Your first step will be to decide the source of the disc image.  You can either build an image using a 
master loaded into the Disc Publisher, or you can build an image using files on your PC.   

From Files on PC 
Select Create Image: Files  from the Project Type drop-down list. 
You will also need to specify the Disc Type.  Your choices are 
CD, DVD, and BD.  An image created as one type cannot be 
burned to other media formats; you cannot burn a CD image to 
DVD, for instance. 
To select the files that will be included in the disc image, click the 
Add Files button.  This will open the PrintWrite 2 Browser, 
allowing you to add the files you want to include in the disc image.  
Like all other project types, you can also drag-and-drop or copy-
and-paste files into the file list. 
Once the file list is complete, click the Browse button to select the image location. 

From Publisher 
Select Create Image: Publisher  from the Project Type drop-down list. 
To create an image using a disc, you will only need to select the location in which the image will be 
created.  Click the Image button to select the location the files will be stored, the name of the 
directory in which they will be stored, and the name of the image file or files. 
The master disc from which the image will be built is loaded into the Disc Publisher Input Hopper, 
and will be loaded automatically when you submit the project. 
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Pause

Resume

Cancel

View Job 

Defining the Image Location 
Regardless of the source of your disc image, the structure of the image will be the same. 
The main image file (with the .di extension) and any associated files will be saved in a directory with 
the same name as that which was entered.  In the example to the right, the name entered in is 
KylaAudioCDImage; a directory of that name will be created in the current directory (Audio).  The 
image files will be created in the KylaAudioCDImage directory. 

Edit/Submit Project 
Click the Submit button to submit your project when you are ready to do so. 

Erase Disc (Local Client Only) 
The Erase Disc project allows you to clear data off erasable media.  Select the Erase Disc project. 

Erase Method  
Select whether you want to perform a Quick Erase of a Full Erase.   

Select the Number of Copies 
Use the Number of Copies control to specify how many discs you would like to 
erase. 

Edit/Submit Project 
Click the Submit button to submit your project when you are ready to do so. 

The Job List Drawer 
Once a project has been submitted, it will appear in the Job List drawer.    
To view the Job List drawer, click the Show Job List button.  The drawer will 
expand from either below or above the main window, depending on the 
vertical placement of the main window on your desktop. 

The Job List will show the state of running and waiting jobs, as well as a count of the completed 
discs for each job.  In addition to the job status, the job list will specify which PC originated the job 
by including the PC name before the Job Name.  In the example above, two PCs named 
PC_Graph and PC_Video have jobs currently in the job queue.  
The Job List will also show jobs currently or queued for transfer when operating as a Remote 
Client. 
If you have several jobs in the list and need to delay one or more jobs for a job that needs to be 
completed as soon as possible, you can Pause the jobs that you want to wait to run until after the 
priority job.   
The Pause button can only be applied to jobs in a Ready state; any job listed in bold with the status 
showing as inProcess cannot be paused. 
Highlight a job and click the Pause button to place the selected job in a holding state.  The status of 
paused jobs will show as hold.  Once the priority job has begun, click the Resume button with the 
held job selected.  
Resume can only be applied to jobs listed with a hold status.  Highlight the held job and click the 
Resume button to have the job continue. 
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Cancel can be applied to any job in any state other than Finished.  Doing so will halt the 
highlighted job after any discs currently being burned or printed are complete, or immediately if the 
job is not currently active.  Click the Cancel button to cancel the currently selected job in the list. 
Use the View Job button to review the contents of a job showing in the Job List.   

Job List Controls and Remote Connection 
You will only be able to control or view all jobs in the Job List from a PC running the Local Client, 
meaning from the PC that is connected directly to the Disc Publisher.   
If you are a Remote Client, meaning you are submitting the jobs to the Disc Publisher connected to 
a PC other than yours, you will only be able to use these controls on jobs your PC has submitted.  
In the example shown above, the user who submitted the jobs from PC_Graph will not be able to 
use the Job List controls to Pause, Resume, Cancel, or View the job submitted from PC_Video, 
for instance.   

Working with Saved Projects 
If you have Disc Publishing projects that you will be running repeatedly, saving the projects 
will save you the time of rebuilding the projects each time they need to be run. 
Once a project has been created, save the project by selecting Save from the File menu or by 
clicking the Save Project button in the toolbar (shown to the right). 
A browse window will open.  Once you have selected the location for the saved project and entered 
the name under which you want to save the project, click the Save button.  The project that you 
created can now be opened and run as many times as needed without having to remember the 
contents and settings of the project. 

File List and Print Image for a Saved Project 
A saved project file does not actually contain any of the files in the File List or the selected Print 
Image.  Instead, it is saving the locations of those files.   
While this is a more efficient use of hard drive space, it does mean that the actual files listed in a 
saved project cannot be deleted, renamed, or moved to a different hard drive location as long as 
the saved project will be used. 

Opening a Saved Project for Review 
There are three methods of opening a saved project for reviewing the project’s settings prior to 
submitting the project. 

1. Double-click the saved project icon in Windows Explorer 
2. Using the Open option in the File menu to browse for and select the saved project 
3. Clicking the Open Project button in the toolbar to browse for and select the saved 

project  
All three of these options will show all of the files that were selected, as well as the print image, 
Number of Copies, Volume Name, Project Type, and various Job Option settings as they were 
when the project was initially saved.   
You can make changes to any of the project information prior to submitting the job without changing 
the saved project itself. 

Submitting a Saved Project without Review 
If you are certain that a saved project is set up exactly as you need it to be and you don’t need to 
review the project, you can drag the saved project icon into the opened Job List for immediate 
submission.  The job will be submitted into the Job List and will run according to the project settings 
at the time the project was saved.  
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Using SureThing Merge Fields 
SureThing CD and DVD Labeler includes the ability to add Merge Fields to any label design, using 
data that you supply.  This can be used for a number of conveniences, such as serializing the discs 
you print, adding specific information to a production run with a stock label image, or personalizing 
the discs being printed by adding the names of the recipients to the discs. 

The data that you supply must be in a .csv format, which can be created using Excel. 
 
 
To add a Merge Field to a label design, select Insert Special Fields in the 
Text toolbox, as shown to the right. 
 
 
 
Next, select Merge Field in the Field Type column.  Click the Field Settings button to select the 
data file.   

 
 

Use the browse button to select 
your .csv merge data file.  All 
merge fields on the label must be 
from the same merge field data 
file. 

If the first row of data contains the 
field names, place a check in the 
Use first record for field names 
box.  

It is recommended that you 
always include the field names 
as the first record in your .csv 
file.  This will allow you to more 
easily identify the field you are 
adding to your label. 

Click the Set button when you 
have selected your merge field 
data file.  
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Select the data field you want to add to your 
label by highlighting that field in the Data 
column and clicking the Insert button.  Since 
the option to use the first record for field 
names was selected in the prior steps, the 
names of the fields are displayed for ease of 
data selection. 
Note that you can insert more than one field 
into the same text box at a time.  You can 
also add text to the text box between field 
selections without closing the Insert Field 
window. 

Click the Close button when you are finished 
adding merge fields to your label. 

 
 
In the example shown to the right, the 
City, State, and ZIP fields from the data 
file have been added to a single text field, 
along with text between the merge field 
values.   
You can add more than one text field 
containing merge fields to a single label. 
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Connection Troubleshooting 
Local Client Only 
Shortly after the Disc Publisher is initialized, the state of the Disc Publisher should show as Online in 
the Publisher Information drawer.  If, however, more than a few minutes have passed with the status 
showing as Stopped or Offline, try the following suggestions: 

1. Shut down and restart PrintWrite 2 on the Local Client PC.  The Publisher Status may show 
correctly when PrintWrite 2 launches again. 

2. Confirm that the Local Client PC is running and that the PrintWrite 2 services and Server 
Manager are running.  These services should be running even if the PrintWrite 2 
application is not open.  Use the PrintWrite 2 Monitor application to check the status of 
these services if PrintWrite 2 is not open.  If the services are not running, reboot the Local 
Client PC. 

3. Confirm that the Disc Publisher is on and connected to the Local Client PC.  If not, connect 
and turn on the Publisher.  Next, select Publisher Utilities from the Utilities menu and 
click the Restart Services button to restart the PrintWrite 2 services.  You will also need to 
close and re-open the PrintWrite 2 application. 

4. Confirm on the Local Client PC that the Disc Publisher is in an Online state.  If the state of 
the Publisher is showing as Offline, open the Publisher Utilities on the Local Client PC and 
click the Diagnostics button to clear the Offline state. 

 

Remote Client Troubleshooting 
It may take as long as a few minutes for the Remote Client connection to show as having been made.  
If, however, more than a few minutes have passed with the connection not completing, try the 
following suggestions, in order: 

1. On the Remote Client PC, confirm you have selected the correct Local Client PC in the 
Remote Servers Found list in the Remoting Utilities. 

2. Shut down and restart PrintWrite 2 on the Remote Client PC.  Communication may be 
restored when PrintWrite 2 launches again. 

3. Confirm that the Local Client PC is running and that the PrintWrite 2 services and Server 
Manager are running.  These services should be running even if the PrintWrite 2 
application is not open.  Use the PrintWrite 2 Monitor application to check the status of 
these services if PrintWrite 2 is not open.  If the services are not running, reboot the Local 
Client PC. 

4. Confirm that the Disc Publisher is on and connected to the Local Client PC.  If not, connect 
and turn on the Publisher, then restart the PrintWrite 2 services on the Local Client PC.  
You will also need to close and re-open the PrintWrite 2 application for the connection to 
complete. 

5. Confirm on the Local Client PC that the Disc Publisher is in an Online state.  If the state of 
the Publisher is showing as Offline, open the Publisher Utilities on the Local Client PC and 
click the Diagnostics button to clear the Offline state. 

6. Confirm that PrintWrite 2 on the Local Client PC is configured to allow your PC access to 
the Disc Publisher in the Administrator Utilities.  Be sure to check both the Share 
Publisher and Client List settings. 

7. Confirm that TCP Ports 10450 and 10451 are active as exceptions in any Firewall 
applications that are running on your network on the Local Client PC.  For Windows 7 
Firewall, make sure the ports are active in both the Incoming and Outgoing exception 
lists.   

8. Allow File and Printer Sharing in your Firewall Exceptions list on the Local Client PC. 

Be sure to allow enough time to pass between each attempt to connect to the Local Client PC.   
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Requirements to Allow Remote Client 
Connections 

Please consult with your Network Administrator prior to making any 
changes to the firewall or network settings on your PC! 

 
For PrintWrite 2 installed on a Local Client PC to allow Remote Client connections to be made, the 
following configurations on the Local Client PC must be set: 

1. For Windows 7 and Vista, User Account Control must be set to OFF on the Local Client 
PC.  Changing this setting will require a reboot of the PC. 

2. PrintWrite 2 and Disc Publisher hardware must be installed on the Local Client PC. 
3. Ports 10450 and 10451 must be opened in any Firewall application as TCP Ports on the 

Local Client PC.   
For Windows Firewall, the option to do this automatically is offered during the Disc Publisher 
installation. 
If you are using a Firewall application other then Windows Firewall, these ports will need to 
be added manually to the Firewall Exception list. 

4. ServerManager.exe must be added to the Firewall Exception list as an allowed application.  
Depending on firewall configuration, you may be asked to allow ServerManager.exe after 
the PC is rebooted; if you are asked, answer that ServerManager.exe should be allowed. 

5. Allow File and Printer Sharing in your Firewall Exceptions list on the Local Client PC. 
6. The Local Client and Remote Client PCs must be in the same Domain or Workgroup.   
7. The Local Client and Remote Client PCs must be on the same Network Gateway and on the 

same Subnet Mask through the first 3 octets (the Subnet Mask will appear in the Network 
Connections TCP/IP Properties as 255.255.255.0 with 255.255.255 being the first 3 octets). 

 

Technical Support 

For technical questions or support issues, contact Microboards Technology technical support:  
 

United States 
PH: 952-556-1639 
FAX: 952-556-1628 

support@microboards.com 
www.microboards.com 

 

Europe 
PH: +44 (0) 845 230 7800 
www.microboards.co.uk 

Japan 
PH: 03-3561-2266 

www.microboards.co.jp 

 
Please also have the Model and Serial Number of the Disc Publisher you are using with PrintWrite 2. 
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